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1 INTRODUCTION

1.1 Problem Definition:

Computer market is the most dynamic market of the contemporary World. Leader sectors of this market changes time to time. Today, embedded electronics drive the computer market.

Since the embedded system is dedicated to specific tasks, design engineers can optimize it, reducing the size and cost of the product This feature makes embedded products the shining star of the market. Moreover, as it is a developing technology, there is not a fully robust development environment for it so embedded electronic environments are seen as a forsaken palace of software engineering. 

A misleading view to embedded software is that, this technology is mostly concerned by electronic engineers however rapid development in embedded technologies calls for special software engineering techniques.  As a result of these technique and obvious difference between high level programming techniques, a special development environment is required.

To provide personal for this special software techniques most of the computer engineering departments teach corresponding courses. Middle East University Computer Engineering department (METU-CENG) is one of these departments. In 2006- spring term, METU-CENG staff decided to use PIC microcontrollers instead of INTEL microcontrollers and a TA of CEng336 course, Alper KILIC, developed a special board for the course CENG-336.However, using such board and developing software projects brings some problems as below:

· Frequent upload of code to board is time consuming,

· Microprocessor and their components are so sensitive devices that small lack of care causes malfunctions, most of the time these malfunctions are not recoverable and they cost considerable amount of money and time ,
· Even there are emulators for PIC and its components , most of the time they require technical background which is generally not related at corresponding courses,

· METU-CENG staff and students prefer UNIX environment for courses however current emulators and development environments developed for Windows environment,

· Software engineers prefer vi as a text editor however such a development environment does not exist,

· Current Integrated development environments(IDE) provides a emulators  for the track of code through registers and memory however they do not provide such features for components like LCD, Led Display , Keyboard etc

· Platform independency is much desired feature for every kind of applications, especially students have different operating system choices; this makes platform independency more valuable.

1.2 Project Scope and Goals

Main purpose of our project is to develop an IDE built on eclipse with the feature of emulating the board for CENG-336 course. However as an expansion point we will aim a general use IDE plug-in that can be used for PIC programming. The scope and features of the projects are stated below:

· Compiler: IDE will compile given PIC-assembly code in to hexadecimal code and will generate compile-time errors for syntax and semantics errors.

· To avoid hardware malfunctions, emulator is needed for the PIC microprocessor and components. Emulator will specially configured to PIC board used in CENG-336.

· IDE will check paging errors , if code exceeds  page limits IDE will give warning,

· Run Time error: checking in simulator phase will be implemented. For instance stack overflows will be detected.

· Project Templates: To reduce time consumption for common projects templates will be provided.

· Workspace: Working environment of user will be saved therefore user setting such as opened files, emulator settings will be remembered.

· Debugging: Programmer will be able run code in emulator, will be able to put breakpoints, watch registers, and track memory-stack.  Programmer can modify registers, memory during runtime.

· Code Completion, Interactive Help: During coding stage IDE will give assistance for the completion of commands and give warning in the case of syntax errors. Programmer will be able to get instance help about commands, for instance user will highlight the command or register, call help and help screen will display corresponding information. Calling help could be by a hot-key etc

· Data Explorer & Types: One of the challenging parts of low level programming is that they do not have data structures like high level programming languages. Our solution for the matters is user-defined data structures as collection of register, memory locations. Moreover user can tag certain parts of code to define data structure. These structures can be followed by a class-view like window.

· Favorites Code Block: Programmer can tag certain parts of the code as favorite and quickly jump to that location.

· Hot-Key Feature: Programmer can reach certain features of the IDE and simulator via hot-keys. Hot-keys can be defined by users and IDE will provide some common templates such as Visual Studio key settings or MPLab key settings.

· Component Feature: All components in pic-board (CENG-336 board) will be attachable and unattachable. User will be able to attach or unattach these components according to project requirements. Moreover as an open issue user will be able to create new components through a wizard step-by-step and attach this to simulator.

· Some common libraries will be provided to user like LCD, Clock-Timer commands.

· Clock-Frequency calculator: Programmer will be able to measure performance of the program or code segments. Clock cycles will be provided as a measure unit.

· Plug-in Feature: Programmers who wants to add new feature to IDE be able to write their own plug-ins and import them.

· Search/Replace: Programmer will be able Search/Replace keywords through project or current document or in selection.

· Higher Level to PIC : This feature is an open issue, we are thinking about designing a higher level language or optimizing a common used higher level language, possibly C, to write PIC programs. IDE compilation feature will compile this higher level language and produce PIC-assembly and then hex file.

1.3 Usage Areas:

Titansoft development environment will be a flexible development environment by plug-in mechanism.

UNIVERSITES: The main purpose of this project is to establish a development environment for CEng336 course. But every university who demands a robust development environment for corresponding course can demand and use   this development environment. As it visualizes the codes of the student, it can be helpful in learning process. Moreover, this can reduce the cost of universities and they can save both money and time. 

COMPANIES: This development environment can also be used in industrial area if the company is developing an embedded system which is supported by Titansoft plug-in mechanism.  Companies using this development environment can shrink the costs. 


1.4 Design Constraints:


· TIME: Time constraints are given in the syllabus. According to syllabus, we have approximately 6 months to finish the project and deliver it to end user. We are at the design phase and we have to produce a prototype within 6 weeks time.  Detailed time constraints are stated in the Schedule part of this report. 

· LANGUAGE: We decided to use JAVA language as implementation language. It allows us reaching many documents and easy programming. There are many plug-in and development environment example coded with Java and we can get benefit of these developers’ experiences.  However, we are worried about the execution time of java codes compared to C++ codes

· MAINTENANCE: Titansoft development environment will require minimal maintenance. Moreover, if users want to update the development environment,  user should save the newly distributed plug in to predefined location and then s/he can use the upgraded version of the development environment

· PERFORMANCE: As java is used as a programming language, efficiency care in programming should be taken.  Otherwise the latency problem will not be handled.

· USER INTERFACE: Designing a user friendly interface is our one of the most important aim. Some students believe that developing an embedded system is boring.  This development environment should help student and other users by reducing the latency of programming, and quick accessing some highly used tools vice versa.

1.5 Design Objectives:

· Extendibility:  As stated above, embedded market is a developing market. If this development environment is intended to be used also in the future, it should be updated regularly. The plug-in support of the Titansoft development environment realizes this purpose and makes it flexible and extendible. 

· Portability: One of the main drawbacks of the currently used development environment is that it could not be operated under UNIX machines. Owing to Java, this development environment is platform independent. 

· Usability:  As this programs` candidate users are students, we should put extra effort to design user friendly development environment. This will ease the task of students.

2 REQUIREMENTS

The details of hardware and software requirements were stated in the requirements analysis report. But IDE programming mentality has been changed and updated hardware and software requirements are given briefly below. 
2.1 Hardware Requirements:

· CEng336 Pic Board

· Development PC with

512 MB RAM

30 GB Free hard disk space

Internet Connection

Intel Pentium IV 1.6 GHz or equivalent AMD

Parallel Port
· For End User
256 MB RAM

150 MB free hard disk space

Graphic card

Mouse

Intel Pentium IV 1.2 GHz or equivalent AMD

Parallel Port
2.2 Software Requirements:

· Development Phase:
Eclipse software development kit

MS Windows

UBUNTU 5.x

MS Office Word

MS Visio

Smartdraw
· End User Needs:
Eclipse SDK

Any platform having a compatible Java run time environment is enough for end user.

2.3 Functional Requirements:

Main functional requirements are listed below.

· Emulation:
Sometimes programming the processor will not be enough, user may want to see the simulation of board components via software. Development environment will emulate the codes written by user in another window.
· Enable/Disable Transfer:
In some cases, code transfer from computer to processor should be suspended in order not to damage the board. After solving problems, user can enable the data transfer.
· Save/ Load:
User should be able to save his/her projects under requested files. Then users should be able to load it and continue his/her projects. Save/load functionality can prevent data and time loss.
· Add/Remove Component:
User may want to add or remove a new board component in emulation part. These components will be found in development environments library. 

In some cases, users want to remove components in order to see emulation clearly and increase the execution speed of the program.  
· Error Handling:
User should see his/her mistakes and debug the code. Efficient error handling is required.  Paging error handling and run time error recovery should be considered specially. 
· Hex Conversion:
Codes should be translated into .hex file in order to be interpreted by the development environment. 

· Breakpoint Setting:
User can set the breakpoints and trace his/her code efficiently. 
· Register Watching:
Sometimes users may want to see the content of the registers in order to understand the working mentality of assembly language. 

2.4 Non-functional Requirements:

Non functional requirements is given below briefly 

· User Interface: 

User interface is the interface of the eclipse which is enriched with plug in features. The interface should be robust and ease the workload of students.  Pretty printing may help students debug their code easily.
· Maintenance:

After delivery, the program should be maintainable. As stated before, embedded technology is growing rapidly and new hardware and software products are released to market. Thanks to plug in feature, development environment can be updated. 
· Platform Independency:

This development environment should be platform independent in order to meet teaching staff of METU-CENG and some students who desire to program embedded systems in UNIX. 
· Search and Replace:

User can search and replace code blocks so s/he can correct large block of mistakes.
· Reliability:
The development environment should be as robust as possible. All modules should make their work without interrupting the normal routine of another module.

3 SCHEDULE

3.1 Gannt Chart
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3.2 Mission Set

· Finished Activities:
Customer Communication

Specification of Requirements

Initial Design Report

Learning the language and tools

· Undone Activities:
Plug in designing 

Design

Establishing Prototype
Interface Construction

Programming 

Adaptation of units

Testing

4.USE CASES
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5. General Working of The Styx

In order to illustrate general working mechanism and for the sake of giving intuitive idea of the mechanism below DFD diagrams are drawn.
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Level 2 DFD
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Addition to Working Mechanism 

Since the internal structure of  our application is considered  more in final design, a need occurred  to expand the data flow model .  
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Below is the data flow model of  our application about the board.(LEVEL 3)

Below is the data dictionary for the given DFD  above:

	Name
	Keyboard input

	From
	User

	To
	Interact with user

	Format
	action/mouse, action/keyboard

	Description
	User pushes on the keyboard buttons of the virtual board


	Name
	Reset button input

	From
	User

	To
	Interact with user

	Format
	action/mouse, action/keyboard

	Description
	User pushes on the reset button of the virtual board


	Name
	.hex file

	From
	File Directory

	To
	Input File Manager

	Format
	.hex

	Description
	The hex file includes the necessary information for simulation.


	Name
	Program Counter Value

	From
	Execute

	To
	Execute

	Format
	Internal stucture

	Description
	The program counter changes  after an execution of a single instruction


	Name
	Memory change request

	From
	Execute

	To
	Load memory and ports

	Format
	Internal stucture

	Description
	After an execution of an insturction a chge in the context of data memory may be required.


In the Following Chapters we will go into internal structure of our program technical details of the styx.
6.Compiler

Styx’s compiler main function is to convert PIC assembly code into executable format, i.e. compiler’s main part is assembler.  Compiler will take higher level language of which codename is Charon (ferryman that carries deads  from living [ok it is quite contradictory that deads in living world but let’s say they are in buffer ( ] world to underworld over Styx) generate Pic assembly code as intermediate language and assembler will produce pic executable code as final step of compiler execution steps.

For the sake of better understanding how compiler works examine the sequence diagram below
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Compiler Working Phase : 

· Eclipse(user Interface) initiates compiling process .

· Compiler takes Charon code as input, produces pic assembly as intermediate language in the case of any error , returns error messages to eclipse and eclipse will show these errors to user. 

· Assembler takes pic assembly and produces executable assembly code. Assembler returns code to compiler and compiler sends code to eclipse. Sending is  intiutive , assembly does not send any code to eclipse technically it sends only a message saying executable is ready for  further processing.

6.1 Compiler Internal Structure 

Compiler of Charon (High Level Language) will be built using Antler. Antler is simply just compiler of compilers ... In other words its a tool or it can be defined a language used for building compilers . In our project Antler will be used to produce PIC Assembly language. Antler will parse Charon Code and produce a parse tree then will produce intermediate language (Pic Assembly) via traversing parse tree. However , Intermediate code is still needs to be processed in order to be able to be executed by a PIC microchip. For the sake of this purpose an assembler will produce target hex code .

Antler produced Compiler seems to  handle most of the cases however still assembler and High Level Compiler need to communicate with each other therefore a wrapping class will be used for High level compiler and assembler. From this point , class diagram will be used for illustration of internal Structure of the code.  
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Compiler : 

The most general class that is composed of AntlerCompiler and Assembler Class. Main purpose of the class is to  handle transformation activities done by sub-classes and connects this output to Eclipse.


Attributes:


charonCode:String : Attribute holds the code that is read from file.

Errors:String : After compile method is called this attribute is filled with error string if any error exists.

Methods:
setCharonCode(String code): set corresponding attribute to argument code.

getErrors(): get corresponding attribute of the compiler class.
compile() : Initiates compiling process by calling transform functions of components. For the sake of clarity , AntlerCompiler.transform() called and corresponding String is transferred to Assembler and Assembler.transform() is at each phase errors are checked and corresponding codes are set to classes *Code attributes.

Components of Compiler:
AntlerCompiler:

Attributes:

assemblyCode:String : Attribute holds the code that is transformed.

Errors:String : After transform method is called this attribute is filled with error string if any error exists.

Methods:
transform(String code) : triggers Antler to generate Assembly code then sets assemblyCodeString.

getAssemblyCode(): get method of corresponding attribute,AssemblyCode .

reset() : resets attributes of the object.

AntlerGeneratedClass: These Classes are generated by antler in order to parse code.

Assembler:

Attributes:

hexCode:String : Attribute holds the code that is transformed.

Errors:String : After transform method is called this attribute is filled with error string if any error exists.

Methods:
transform(String code) : triggers Antler to generate Assembly code then sets assemblyCodeString.

getHexCode(): get method of corresponding attribute,HexCode .

reset() : resets attributes of the object.

6.High Level ASM Language , Charon, and Design of The Antler Compiler

In initial design , high level language design has left as an open issue. In this part design of the high level language is handled. High Level Language will called with codename Charon.

Charon is not a completely new language. It will be based on C syntax. In fact Charon is a hybrid language, in a usual Charon code asm segments and C part will be in the same code. The reasons of this design is that PIC chips generally has very limited sources that they do not allow complex high level language concept moreover implementation of simple types are very complex and source demanding . For instance implementation of floats is very complex due to 8-bit register structure and limited memory size. 

Based on limited Resource issue implementation of class like structures again becomes meaningless, since implementation of such structures produces very long code segments and based on the fact that program memory in pics is very limited it becomes useless and even deceptive since most of the time programmers will not prefer such structures in order to reduce consumption of system resources.

To sum up, main issue of  designing a high level language is using limited resources very efficient . In fact this may seem a quite obvious since for every language design its crucial for optimization however at some points optimization can be neglected. For PIC programming optimization is the heart of designing language since philosophy of PIC programming is making big things by less system resources because most of the time each unnecessary generated code segment means extra chip which means extra cost to companies. 

Based on above facts , Charon designed in the lights of below facts :

· Avoid language constructs that generates long segments and hard to optimize,

· Must allow programmer to write asm codes , namely Charon must contain asm,

· As being a high level language,Charon must generate classical code segments.

6.1 Constructs of Charon 

Cexpr   :  
expr RelationalOperator expr

Expr   
 : 
arithmetic_expr | rvalue | assignment | bitwise | asmSegment

asmSegment : { asmCode }

asmCode :  PIC assembly code, do not parse directly pass it

Exprlist :  { (expr “;”)* }

arithmetic_expr : Expr arithmetic_operator Expr

bitwise  : rvalue bitwise_operator rvalue

assignment : register assign_op Expr

rvalue : 
register | Numeric 

register : #<Registername>

Numeric :  (0....9)*

RelationalOperator :    “||”  | “&&” | “==”  | “^”  | “!” | “!=”

bitwise_operator : “|” | “&” | “<<” | “>>” | “^”

assign_op : “:=”

If-then-else : 


If cexpr exprlist1 else explist2 :

While do :


While cexpr do exprlist

7.Central Processing Unit

Processing unit is equivalent of the parts of the chip except memory. Processing unit is the most important structure of the emulator since all instructions executed in this unit. Instructions execution rules are defined and applied at this level.

In basic manner CPU execute the instruction and applies the pre-determined side effects based on current instruction.

In order to simplify working mechanism of Styx’s CPU , instruction set is classified as follows : 

Load/Write instructions

Operations 

In the following sections details of how CPU handles these type of instructions is explained.
7.1 Load/ Write Instructions
In PIC chips all load/write instructions handled via registers , namely if there you can load a data into a register from other register , generally one of these register is working register. The same situation applies to write operations with extra literal writing to registers.

In PIC chips you can load or write values to memory locations however this is not accomplished via a single instruction. Like most of the process in PIC you have set series of configuration bits in order to write or read EEPROM data with all these things at the basic it is again simple a register load/write instruction with a little difference that after applying corresponding operations values at special registers are loaded from EEPROM or written onto memory.

To understand how these different kind of PIC Load/Write Instructions examine following diagram.
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Load/Save State: At this Stage source and destination are examined for making proper functions calls.

Read State : After Examination of source/destination corresponding functions calls made and values are fetched (calling functions  read/write functions of memory) 

Final State :  This state is a classic state of every instruction end checks Status register in order to make proper changes/side effects to system. For instance if “BSF EECON1, RD” value at address pointed by EEADR register must read from, and similiar example for wrting to memory. So writing or reading from memory is can be done only side effects.

CPU communicates with memory manager via its function fetch which takes two arguments one for source and other for the type of the source. According to type argument CPU fetches from corresponding place which can be EEPROM,File Registers or program memory. If you want get specially a bit then you call fetch with 3 arguments where 3rd argument corresponds to bit number. The same conditions are applied to write function of CPU.

Another Important function is next_instruction, set_next_instruction,get_next_instruction and reset functions. 

next_instruction() :  executes next instruction and increments PC and returns next instruction.

set_next_instruction(int target): for special conditions sets PC to target.

get_next_instruction() : returns the value of PC without incrementing it.
reset() : resets CPU namely reset memory, PC.

7.2 Operations 

This kind of expressions change the value of target (must be register) with special kind of effects in a single instruction. For instance dec,inc or addf,subf instructions are all changes target value in arithmetic operations. The main issue of this instructions is to handle side effects and some constraints of registers. For instance when there is a overflow on register STATUS register must be changed properly. Example to constraint is that bit values of special registers can not be altered they are read only , namely even if you can tried to write them their values must not be changed .

7.3 Execution Mechanism of Instructions

In the lights of the facts determined in sections 3.1 and 3.2 general execution diagram of instruction can be shown as below :
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8.MEMORY ORGANIZATION

There are three memory blocks in PC16F877 microcontroller unit which are:

 8,092 14 bit FLASH program memory

 256  8 bit EEPROM data memory (nonvolatile)

 368   8 bit data memory or registers (“File Registers”)

Below is the description of how memory organization will be implemented:

    It is decided to represent each  memory block by a different abstract class. An inheritance from a base “memory block” class is not preferred because there are  major behavior and attribute differences and an inheritance will not make the works much easier.

The read and write access to both data EEPROM  and FLASH program memory  take place indirectly through a set of Speacial Function Registers (SFR). This six SFR which are in the file registers are :


EEDATA


EEDATH


EEADR


EEADRH


EECON1


EECON2

In our design the read and write functions of each memory block's abstarct class' do not read these values and/or modify them. These works will be done outside the memory blocks' methods

because if not, the modularity of each memory block will decrease.

The file registers are composed of  four banks which contain special function registers and general purpose registers.Some special function registers are placed in four of the banks and a value changed in one of them reflects also to the other banks. But also the read and modify functions of  data memory, read and modify only one bak at a time.The change on the other banks are decided to done outside these functions by group members.

Below is the class diagram of memory blocks and some description about attributes and methods:

Program memory class represents the program memory of the microcontroller. Since the program memory contains 8092 14 bit cells, Program Memory class has a short int array of size 8092.

With a given address to  read_at_address(int addr):short as input, the function reads the cell in the in the address and returns it. 

With a given address and a short value to write_to_address(int addr,short input):void the function updates the value in the given address with the given value in the second argument.

The function clear_block():void clear all the values of program memory to zeros.

EEPROM class represents the unvolatile EEPROM data memory of the microcontroller. Since the program memory contains 256 8 bit cells, Program Memory class has a char array of size 256.

With a given address to  read_at_address(int addr):char as input, the function reads the cell in the in the address and returns it. 

With a given address and a short value to write_to_address(int addr,char input):void the function updates the value in the given address with the given value in the second argument.

The function clear_block():void clear all the values of EEPROM to zeros.

Data memory class represents the file registers of the microcontroller. Since the data memory( can be called file registers also) contains 4 banks of 128 cells, data memory class has four char arrays of size 128. 

With a given address to  read_at_address(int addr):char as input, the function reads the cell in the in the address and returns it. 

With a given address and a short value to write_to_address(int addr,char input):void the function updates the value in the given address with the given value in the second argument.

Data memory also has functions instead of getting the address value, it gets the enumaration constant which is the name of the file register.
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9.Interface

1.1.Class Diagram : GUI Operations

   In order to generate the GUI operations, some components of javax.swing package will be used in the GUI class such that a MenuBar and a number of buttons, labels and icons.The buttons, labels and icons will be used in the Tool Bar, Menu Bar in order to relate each component to a button, label or icon where necessary. 
    GUI class basically provides a way to perform operations that require user interaction. For example selecting a Menu Item or clicking on a ToolBar icon.Each action stated triggers an event indicating that the user demands an operation. These events are stated as follows in the ‘Graphical User Interface ‘ class diagram:
MenuItem_actionPerformed(ActionEvent)

ToolBarIcon_actionPerformed(ActionEvent)

Notation:

MenuItem_actionPerformed(ActionEvent)

ToolBarIcon_actionPerformed(ActionEvent)

• “MenuItem” represents all possible Menu Items of SYTX such as jMenuProjectSave,

jMenuViewProgramMemory. Similarly “ToolBarIcon” represents all possible ToolBar icons of SYTX such as a build icon, a StepThrough icon and so on.

• ActionEvent can represent either choosing a Menu Item or selecting a ToolBar icon.
  For example when the user selects the Program Memory Option of the View menu, the j_ViewProgramMemoryactionPerformed(ActionEvent) event will be triggered and inside the event, the view_program_memory method of the View_Manager object will be called in order to perform the corresponding operation.

   GUI class also encapsulates a File_Manager, a Compiler, a Debugger , a Project_Manager,a View_Manager and an Editing_Manager classes whose details i ve explained below:

  File_Manager object will be used for all file operations such as opening,saving or closing the project and exiting from the program.There will also be an additional get method in File_Manager object which returns the Vector holding the file objects that have been saved and stored in the ‘file_list’ Vector previously.

  Project_Manager object will be used for all operations that a user can perform on projects such as opening,saving or closing the project; adding/removing the specified files from the current project,invoking the compiler in order to compile the current project and also an additional get method in order to return the ‘project_list’ Vector holding the Project objects that have been saved and stored in the Vector previously.By current project,we mean the last element of the ‘project_list’ Vector.

   Editing_Manager object will be used for all editing operations such as copying,pasting,cutting and deleting of the selected texts,selecting the whole text,searching for a text which is specified by the user and going on the search in order to find the next location of the specified text,replacing a selected text with a user specified string and going to line location which is again specified by the user.

   For all of these three class objects namely Editing_Manager, Project_Manager and File_Manager we won’t be implementing the functionalities which are already implemented for eclipse platform,we rather extend those functions in order to adapt Titansoft’s data structure.

  View_Manager object will be used for the following operations ; 

· view_output(string)- the function takes the file name to be compiled and displays the output showing the result of the compile operation.   

· view_project()-the function displays the structure of the current,opened project together with all its source files,header files etc. 

· view_hardware_stack()-the function displays the state of the global stack which is an 8 indexed vector at the time it is called.

· view_program_memory()-the function displays the state of the memory showing for each line of the instructions,which memory register’s value is being changed by the execution of that instruction and what data is held by that memory register afterwards together with their memory addresses. This function calls the function ‘read_at_address(short)’ of Program_Memory class in order to obtain what is inside each memory registers and so then display the result.

· view_EEPROM_memory()-the function displays the state and content of EEPROM by the time function is called. This function calls the function ‘read_at_address(short)’ of EEPROM class in order to obtain what is inside EEPROM and so then display the result.

· view_registers()-the function displays what data is being stored by the file registers by the time it is called. This function calls the function ‘read_at_address(short)’ of Data_Memory class in order to obtain what is inside each file registers and so then display the result.

· open_program_watch(Vector <register_list>)-the function opens a window ‘watch’on the screen through which user can watch the content of each file registers and also of some view variables that s/he adds ,at each step of execution of the code.These operations that should be followed by user are as follows;

             To create a Watch window, user should select View > Watch from the menu bar

[image: image10.emf]
Figure 1.1

The Add Watch Symbol dialog will appear (Figure 1.1).Typing ‘c1’ in the symbol name box will cause the list to scroll to the c1 symbol. Highlight the symbol then user should click the Add button and then click the Close button.Then the user will be left with the Watch window on your displaying the current value of the temporary counter value ‘c1.(Figure 1.2)

[image: image11.emf]
Figure 1.2

The function ‘open_program_watch’ just displays a window on the screen,fills in the address_list vector according to the registers user chooses and then for each address in the address_list, calls another function inside which itself triggers a function ‘read_register ‘which is a function of the class ‘Data Memory’ (Data Memory.read_register(enum)) that reads the register values specified by the address and then returns the data that is stored in that address location.So the function ‘open_program_watch’,returns a vector ‘value_list’ holding the values stored at the  registers that the users choose and displays these values on the watch screen as can be seen from figure 1.2. 
 Debugger object will be used for the following operations ; 

· clear_EEPROM()-this function calls the method ‘clear_block()’  of EEPROM class and as the name implies it clears the EEPROM.

· clear_program_memory()-this function calls the method ‘clear_block()’ of Data Memory class and as the name implies it clears all program memory.

· step_through_code()- for each instruction user steps through over the currently opened file,this function triggers the cpu functions which will be executing each instruction ,incrementing the program counter and update the registers which are being affected by these instructions accordingly.

· add_breakpoint(int)-this function takes the line number entered by the user and put this line value into the ‘break_points’ vector which is an attribute of the ‘Debugger’ class.Moreover another task of this function is to trigger the cpu function which will stop the program at those lines specified in the ‘break_points’ vector.So CPU should be able to access ‘break_points’ vector.That’s the reason why we’ve included a get method inside the Debugger class which returns the   ‘break_points’ vector.

· remove_breakpoint(int)-this function takes the line number user specified and deletes the entry in the ‘break_points’ vector for that line number.

2.1.Sequence Diagram : GUI Operations

2.1.1. Save/Load
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    Save/Load Operations will proceed as follows:

 When the user selects the Save Option from the Project Menu, a jMenuProjectSave_actionPerformed(ActionEvent) event will be triggered informing the GUI that the user demanded to save the project. After that, GUI class will call the save_project method of its Project_Manager object. Finally the Project_Manager object will simply use the write method of the fileWriter class of java.io package in order to save the project in a file.

 When the user selects the Load Option from the Project Menu, a jMenuProjectOpen_actionPerformed(ActionEvent) event will be triggered informing the GUI that the user demanded to open a project. After that, GUI class will call the open_project method of its Project_Manager object. Finally the Project_Manager object will simply use the read method of the fileReader class of java.io package in order to open the project.

 When the user selects the Open Option from the Project Menu, an a jMenuProjectNew_actionPerformed(ActionEvent) event will be triggered informing the GUI that the user demanded to create a new project. After that, GUI class will call the new_project method of its Project_Manager object. Finally the Project_Manager object will simply use the write method of the fileWriter class of java.io package in order to create a new project.

2.1.2. Debug
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    Debug Operations will proceed as follows:

When the user selects the  Add breakpoint option from the Debugger Menu,it starts to fill the break_points vector with the line numbers-representing the break point locations-that s/he enters. After this operation get statement of Debugger class is invoked in order to provide CPU with access to break_points vector.CPU will definitely need to access it since afterwards it will start execution of the instructions when user selects step_through option from Debugger Menus o it should know the breakpoints if there are any.Then while executing instructions,CPU starts to update EEPROM and then Program_Memory since it needed to read some EEPROM and Program_Memory registers .So as a reply to this method ‘read_at_address’ EEPROM and Program_Memory objects returned to CPU, the register values they ve read. Then on this point,CPU still is keeping executing instructions.At some time,CPU wants to name an update on first EEPROM and then Program_Memory registers so this update method of CPU,triggers ‘write_to_address’ methods of EEPROM and Program_Memory objects and the register values are overwritten.Then the user wants to remove some breakpoints s/he has previously added.So ‘remove_breakpoint’ option of Debugger Menu is selected by the user .The updated version of break_points vector (now without the line numbers that are removed) is get by CPU via the getter function of Debugger class. Then the user selects clear EEPROM option from the Debugger Menu so EEPROM’s ‘clear_block’ method  which fills the EEPROM vector with NULL values is called. Then the user selects clear Program Memory option from the Debugger Menu so Program_Memory’s ‘clear_block’ method  which fills the Program Memory vector with NULL values is called. 
2.1.3. Project VIEW/COMPILE
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This schema represents the senario such that ; the user selects view_project option from View menu.In order to identify the current project, View_Manager class first access and obtains project_list vector by using the getter function of Project_Manager class. And then regard the last entry in the vector as the most current one.So then Project_Manager object just displays the  current project’s structure(together with all of its source&header files,libraries it uses if there are any n etc.) Then selecting the compile option from Project menu,the user causes a function call ‘invoke_compiler’ from Project_Manager class.This method triggers the Compiler class to do compilation on the current Project.Then the compiler sends the compilation result to View_Manager object and so by getting the compilation result when the user choose view_output option from View menu,the user causes the call of the view_output method of View_Manager class.
2.1.4. Project VIEW/COMPILE
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   At this scenario, the user first chooses view EEPROM memory option of View menu.This action of user triggers the read_at_address method of EEPROM class by which whole EEPROM registers are read and EEPROM object sends an acknowledge named as ‘read_data’ to View_Manager object who by getting this acknowledge,displays the whole EEPROM registers along with their data.Then the user chooses view program memory option of View menu.This action of user triggers the read_at_address method of Program_Memory class by which whole Program Memory registers are read followed by an acknowledge named as ‘read_data’ sent by Program_Memory object  to View_Manager object who by getting this acknowledge,displays the whole Program Memory registers along with their data. Then the user chooses view registers option of View menu.This action of user triggers the read_at_address method of Data_Memory class by which whole Data Memory registers are read followed by an acknowledge named as ‘read_data’ sent by Data_Memory object  to the View_Manager object who by getting this acknowledge,displays the whole Data Memory registers along with their data.Then the user selects watch option from View menus so the function open_program_watch method of View_Manager class is called as a result of this method ; a watch window is displayed and  the address_list vector is filled by the 16 bit register address values entered by the user .And a function is called with the address_list vector. This triggers the read_at_value method of Data_Memory class which holds the file registers. For each address in the address_list vector, this method of View_Manager class calls ‘read_register ‘method which is a function of the class ‘Data Memory’ (Data Memory.read_register(enum)) that reads the register values specified by the address and then returns the data that is stored in that address location.So the function ‘open_program_watch’,returns a vector ‘value_list’ holding the values stored at the  registers that the users choose and displays these values.

3. General Overview of Interface
For the sake of viewing all classes of Interface together from the aspect of interface below diagram is designed.
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